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Mouse and Keyboard Commands
See Also
To help you navigate, System Watch supports many mouse and keyboard operations. Some of the most 
helpful include:
Double-click

    on Closes dialog box or window, or exits System Watch.
Selects available settings.
Selects available settings.
Moves cursor one character to the right.
Moves the cursor one character to the left.

Spacebar Toggles options between enabled and disabled, or presses a command button.
Alt+ Activates the prompt button to open a drop-down list or combination box.
Tab Moves forward through a dialog box or configuration panel.
Shift+Tab Moves forward through a dialog box or configuration panel.
Ctrl+F6Makes the next drive window, group window, or document window active.
Alt+Tab Cycle through running applications; release Alt at desired application.
Alt+Tab,... Cycle through applications while pressing Tab. Release Alt when you reach the desired 
application.
Alt+Spacebar Activates the Control menu.
Alt+F4 Exits System Watch.



System Watch Menu Commands



Customizing System Watch
See Also         Panel Settings         Dialog Box Settings
With System Watch, you can customize the sensor display to your own needs and preferences. Change 
sensor display colors, or even the displayed font used for the enabled sensors. You can also change the 
sensor order that is displayed in the System Watch sensor window, or select how often you want to be 
alerted if a sensor falls outside specified limits.
To change the sensor appearance:

1 Choose Options... from the File menu.
2 Click the  button next to the color type you want to change.

3 Select or create the color you want to use.
4 Click OK in the Color Selection dialog box.
5 Click OK in the General Options Configuration panel.
To change the sensor order in the System Watch window:

1 Choose Options... from the File menu.
2 Select the sensor you want moved.
3 Click the Up or Down button until the selected sensor is in the desired position.
4 Click OK.

TIP: You can also select the General Options Configuration panel by holding down the right mouse button
and choosing General Options... from the pop-up menu.
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Configuring the Windows Memory Sensor
See Also         Panel Settings
With System Watch, you can configure the System Watch Windows Memory sensor to your preferences. 
You can select the measurement method you want to use, or choose between viewing the amount of 
Windows memory that is used or free, depending on your own needs.
System Watch also lets you select the type of alarm action you want used if your Windows memory falls 
below specified limits. You can choose alarm actions such as doing nothing, which will only display the 
Windows Memory sensor with the selected warning bar color, or you can enable System Watch to display
a recommendation message which can give you helpful tips on freeing up Windows memory.
To configure the Windows memory sensor:

1 Choose Options... from the File menu.
2 Select Windows Memory from the Sensors list box.

TIP: You can also select sensor configuration panels by holding down the right mouse button over 
the sensor you want to configure in the System Watch window and choosing Sensor Options... from
the pop-up menu.

3 Select your desired sensor settings. Click Panel Settings at the top of this window for additional 
information on each setting.

4 Click OK.



Customizing System Watch
Configuring the Cache Hits Sensor



Configuring the Physical Memory Sensor
See Also         Panel Settings
With System Watch, you can configure the System Watch Physical Memory sensor to your preferences. 
System Watch lets you select the type of alarm action you want used if your Physical memory falls below 
previously specified limits.
You can choose alarm actions such as doing nothing, which will only display the Windows Memory sensor
with the selected warning bar color, or you can enable System Watch to play a WAV file to alert you of low
Physical memory. In addition, you can select the measurement method you want to use, or choose 
between viewing the amount of Physical memory that is being used or is free, depending on your own 
requirements. 
To configure the Physical Memory sensor:

1 Choose Options... from the File menu.
2 Select Physical Memory from the Sensors list box.

TIP: You can also select sensor configuration panels by holding down the right mouse button over 
the sensor you want to configure in the System Watch window and choosing Sensor Options... from
the pop-up menu.

3 Select your desired sensor settings. Click Panel Settings at the top of this window for additional 
information on each setting.

4 Click OK.
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Configuring the Virtual Memory Sensor
See Also         Panel Settings
With System Watch, you can configure the System Watch Virtual Memory sensor to your preferences. 
You can select the measurement method you want to use, or choose between viewing the amount of 
Virtual memory that is used or available, depending on your own needs.
System Watch also lets you select the type of alarm action you want used if your Virtual memory falls 
below specified limits. You can set alarm actions such as doing nothing, which will only display the 
Windows Memory sensor with the selected warning bar color, or you can enable System Watch to display
a recommendation message which can give you helpful tips on increasing Virtual memory.
To configure the virtual memory sensor:

1 Choose Options... from the File menu.
2 Select Virtual Memory from the Sensors list box.

TIP: You can also select sensor configuration panels by holding down the right mouse button over 
the sensor you want to configure in the System Watch window and choosing Sensor Options... from
the pop-up menu.

3 Select your desired sensor settings. Click Panel Settings at the top of this window for additional 
information on each setting.

4 Click OK.



Configuring the Physical Memory Sensor
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Configuring the DOS Memory Sensor
See Also         Panel Settings
With System Watch, you can configure the System Watch DOS Memory sensor to your preferences. You 
can select the measurement method you want to use, or choose between viewing the amount of DOS 
memory that is used or available, depending on your own needs.
System Watch also lets you select the type of alarm action you want used if your DOS memory falls below
specified limits. You can set alarm actions for low DOS memory such as playing a WAV file, or enabling 
System Watch to display a recommendation message which can give you helpful tips on freeing up 
conventional memory.
To configure the DOS memory sensor:

1 Choose Options... from the File menu.
2 Select DOS Memory from the Sensors list box.

TIP: You can also select sensor configuration panels by holding down the right mouse button over 
the sensor you want to configure in the System Watch window and choosing Sensor Options... from
the pop-up menu.

3 Select your desired sensor settings. Click Panel Settings at the top of this window for additional 
information on each setting.

4 Click OK.
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Configuring the GDI Resources Sensor
See Also         Panel Settings
With System Watch, you can configure the System Watch GDI resources sensor to your preferences. 
System Watch lets you select the type of alarm action you want used if your GDI Resources falls below 
specified limits.
You can set alarm actions such as doing nothing, which displays the GDI Resources sensor with the 
selected warning bar color, or you can simply choose to enable System Watch to flash the GDI 
Resources sensor. In addition, you can also select the measurement method you want to use, or choose 
between viewing the amount of GDI Resources that is being used or is available, depending on your 
preferences.
To configure the GDI resources sensor:

1 Choose Options... from the File menu.
2 Select GDI Resources from the Sensors list box.

TIP: You can also select sensor configuration panels by holding down the right mouse button over 
the sensor you want to configure in the System Watch window and choosing Sensor Options... from
the pop-up menu.

3 Select your desired sensor settings. Click Panel Settings at the top of this window for additional 
information on each setting.

4 Click OK.
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Configuring the USER Resources Sensor
See Also         Panel Settings
With System Watch, you can configure the System Watch USER Resources sensor to your preferences. 
You can select the measurement method you want to use, or choose between viewing the amount of 
USER Resources that is being used or available, depending on your own needs.
System Watch also gives you the option to select the type of alarm action you want used if your USER 
Resources falls below specified limits. You can alarm actions such as doing nothing, which will only 
display the Windows Memory sensor with the selected warning bar color, or you can enable System 
Watch to display a recommendation message which can give you helpful tips on freeing up Windows 
memory.
To configure the USER resources sensor:

1 Choose Options... from the File menu.
2 Select USER Resources from the Sensors list box.

TIP: You can also select sensor configuration panels by holding down the right mouse button over 
the sensor you want to configure in the System Watch window and choosing Sensor Options... from
the pop-up menu.

3 Select your desired sensor settings. Click Panel Settings at the top of this window for additional 
information on each setting.

4 Click OK.
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Configuring the CPU Utilization Sensor
See Also         Panel Settings
With System Watch, you can configure the System Watch Windows Memory sensor to your preferences. 
You can select the measurement method you want to use, or choose between viewing the amount of 
Windows memory that is used or free, depending on your own needs.
System Watch also lets you select the type of alarm action you want used if your Windows memory falls 
below specified limits. You can set alarm actions such as doing nothing, which    only displays the 
Windows Memory sensor with the selected warning bar color, or you can enable System Watch to display
a recommendation message, which can give you helpful tips on freeing up Windows memory.
To configure the CPU utilization sensor:

1 Choose Options... from the File menu.
2 Select CPU Utilization from the Sensors list box.

TIP: You can also select sensor configuration panels by holding down the right mouse button over 
the sensor you want to configure in the System Watch window and choosing Sensor Options... from
the pop-up menu.

3 Select your desired sensor settings. Click Panel Settings at the top of this window for additional 
information on each setting.

4 Click OK.
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Configuring the System Handles Sensor
See Also         Panel Settings
With System Watch, you can configure the System Watch Windows Memory sensor to your preferences. 
You can select the measurement method you want to use, or choose between viewing the amount of 
Windows memory that is used or free, depending on your own needs.
System Watch also lets you select the type of alarm action you want used if your Windows memory falls 
below specified limits. You can set alarm actions such as doing nothing, which only displays the Windows 
Memory sensor with the selected warning bar color, or you can enable System Watch to display a 
recommendation message which can give you helpful tips on freeing up Windows memory.
To configure the system handles sensor:

1 Choose Options... from the File menu.
2 Select System Handles from the Sensors list box.

TIP: You can also select sensor configuration panels by holding down the right mouse button over 
the sensor you want to configure in the System Watch window and choosing Sensor Options... from
the pop-up menu.

3 Select your desired sensor settings. Click Panel Settings at the top of this window for additional 
information on each setting.

4 Click OK.
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Configuring the Open Files Sensor
See Also         Panel Settings
With System Watch, you can configure the System Watch Windows Memory sensor to your preferences. 
You can select the measurement method you want to use, or choose between viewing the amount of 
Windows memory that is used or free, depending on your own needs.
System Watch also lets you select the type of alarm action you want used if your Windows memory falls 
below specified limits. You can set alarm actions such as doing nothing, which will only display the 
Windows Memory sensor with the selected warning bar color, or you can enable System Watch to display
a recommendation message which can give you helpful tips on freeing up Windows memory.
To configure the open files sensor:

1 Choose Options... from the File menu.
2 Select Open Files from the Sensors list box.

TIP: You can also select sensor configuration panels by holding down the right mouse button over 
the sensor you want to configure in the System Watch window and choosing Sensor Options... from
the pop-up menu.

3 Select your desired sensor settings. Click Panel Settings at the top of this window for additional 
information on each setting.

4 Click OK.
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Configuring the Cache Hit Ratio Sensor
See Also         Panel Settings
With System Watch, you can configure the System Watch Windows Memory sensor to your preferences. 
You can select the measurement method you want to use, or choose between viewing the amount of 
Windows memory that is used or free, depending on your own needs.
System Watch also lets you select the type of alarm action you want used if your Windows memory falls 
below specified limits. You can set alarm actions such as doing nothing, which only displays the Windows 
Memory sensor with the selected warning bar color, or you can enable System Watch to display a 
recommendation message which can give you helpful tips on freeing up Windows memory.
To configure the cache hit ratio sensor:

1 Choose Options... from the File menu.
2 Select Cache Hit Ratio from the Sensors list box.

TIP: You can also select sensor configuration panels by holding down the right mouse button over 
the sensor you want to configure in the System Watch window and choosing Sensor Options... from
the pop-up menu.

3 Select your desired sensor settings. Click Panel Settings at the top of this window for additional 
information on each setting.

4 Click OK.
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Configuring the Disk Usage Sensor
See Also         Panel Settings
With System Watch, you can configure the System Watch Windows Memory sensor to your preferences. 
You can select the measurement method you want to use, or choose between viewing the amount of 
Windows memory that is used or free, depending on your own needs.
System Watch also lets you select the type of alarm action you want used if your Windows memory falls 
below specified limits. You can set alarm actions such as doing nothing, which only displays the Windows 
Memory sensor with the selected warning bar color, or you can enable System Watch to display a 
recommendation message, which can give you helpful tips on freeing up Windows memory.
To configure the disk usage sensor:

1 Choose Options... from the File menu.
2 Select Drive N from the Sensors list box, where N is the drive letter you want to configure.

TIP: You can also select sensor configuration panels by holding down the right mouse button over 
the sensor you want to configure in the System Watch window and choosing Options... from the 
pop-up menu.

3 Select your desired sensor settings. Click Panel Settings at the top of this window for additional 
information on each setting.

4 Click OK.
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Viewing Sensor Histories
See Also
Get a graphical representation of your system resources by viewing the histories of enabled sensors. This
is a handy feature you can use to give you up-to-the-second information of a resource monitored by 
System Watch.
In addition to viewing sensor levels in a histogram format, the System Watch History window gives you 
valuable information such as the resource current level, the highest and lowest value measured since the 
sensor was enabled, and the current alarm setting. System Watch also gives you the flexibility to view 
multiple histories minimized. All the most important information is displayed in the minimized history icon 
such as a miniature graph and the current value measured.
NOTE: To view a sensor history, the selected sensor must be enabled. To quickly determine which 
sensors are enabled, select the Sensor menu. Enabled sensors will have a checkmark next them.

To view a sensor history:
¨ Select the sensor you want to view from the History menu.

The selected sensor history appears, giving you an up-to-the-second report of your system's 
resources in a histogram format.

To view a sensor minimized:
1 Select the sensor you want to view from the History menu.
2 Click the minimize button in the Sensor History window.

The sensor will be displayed minimized. 
TIP: You can also view a sensor history by moving the mouse pointer over the displayed sensor you want 
to view in the System Watch window, holding down the right mouse button, and choosing Sensor 
Histories... from the pop-up menu.
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Always on Top command (Control menu)
See Also
This command is available when you view a sensor history. To access this command, click the Control 

menu  from any sensor history window, and choose Always On Top.
When this command is selected, the open sensor history window appears on top of all other open 
windows. This command is useful if you want to monitor a sensor history while you are running other 
applicatons and you don't want to have to make the sensor history window the active window to view its 
contents.
NOTE: This command option must be set for each sensor history you want to view on top.



Viewing Sensor Histories



Reset Highest and Lowest command (Control menu)
See Also
This command is available when you view a sensor history. To access this command, click the Control 

menu  from any sensor history window, and choose Reset Highest And Lowest. When you select this 
command, the Highest and Lowest sensor measurements are set to the current sensor value.
NOTE: This command option must be set for each sensor history you want to reset.



Viewing Sensor Histories



Options... command (File menu)
See Also
Use this command to customize System Watch to your own needs and preferences. You can change the 
sensor appearance by selecting background, text, normal bar, and warning bar colors. In addition to 
choosing from the pre-existing colors, you can also create your own custom colors to use in the System 
Watch sensor display.
You can preview the colors you select in the sample sensor display in the General Options Configuration 
panel. You can also change the displayed sensor order in the System Watch window, or select other 
options such as selecting to launch System Watch every time you run Windows, or consolidate the sensor
display into multiple columns.



Customizing System Watch
Viewing Sensor Histories



Always on Top command (File menu)
See Also
When this command is selected, the System Watch sensor display window appears on top of all other 
open windows. This command is useful if you want to monitor the System Watch sensor display while you
are running other applicatons, and you don't want to have to make the System Watch the active window 
to view its contents.



Customizing System Watch



No Title command (File menu)
See Also
Choose this command to display System Watch without a title or menu bar. To return the title and menu to
the System Watch display, simply double-click anywhere within the System Watch window.
NOTE: You can also remove the title and menu by double-clicking within the System Watch window.



Customizing System Watch



Exit command (File menu)

Use this command to exit System Watch.



Windows Memory command (Sensor menu)
See Also
This command allows you to enable and display the Windows Memory sensor in the System Watch 
window.
The Windows Memory sensor monitors the amount of free (or used) physical memory combined with the 
amount of virtual memory that is being used. The amount of free Windows memory can also be obtained 
by choosing About... from the Help menu. Don't be alarmed if the value obtained by the About... command
and the System Watch Windows Memory sensor are not exactly the same. System Watch updates its 
enabled sensors once a second, while the About... command displays the value from a snapshot of free 
Windows memory when the About... command was selected, so there may be a slight discrepancy.
NOTE: It is possible that the values displayed in the Physical and Virtual Memory sensors will not add up 
to your total Windows memory displayed in System Watch. This is because it is possible to create a swap 
file larger than Windows can use. When you set up your Windows swap file (virtual memory) using 
Control Panel, Windows gives you the choice of selecting a "maximum" or "recommended" size swap file.
If you enter a size larger than the size recommended, Windows warns that it won't be able to use the 
extra swap file space, and will result in virtual memory plus physical memory not adding up to your 
Windows memory. If this occurs, it is a direct indication that you are wasting disk space on an oversized 
swap file. The PageOverCommit setting, which is covered in INI Advisor, in your SYSTEM.INI file 
determines how much swap file space can be used by Windows.
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Physical Memory command (Sensor menu)
See Also
This command allows you to enable and display the Physical Memory sensor in the System Watch 
window.
The Physical Memory sensor monitors the total amount of physical RAM in your system.
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Virtual Memory command (Sensor menu)
See Also
This command allows you to enable and display the Virtual Memory sensor in the System Watch window.
The Virtual Memory sensor command monitors the amount of free (or used) memory contained in the 
Windows swap file on your hard disk.
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DOS Memory command (Sensor menu)
See Also
This command allows you to enable and display the DOS Memory sensor in the System Watch window. 
When this command is selected, a check mark appears next to the command.
The DOS Memory sensor monitors the amount of conventional memory available (or used). This sensor 
is useful if you occasionally get an "Out of Memory" error when you try to launch certain Windows 
applications. Many Windows applications use a portion of DOS memory to perform certain functions, and 
having too many Windows applications running at one time may cause your DOS memory to deplete. If 
you find yourself frequently in this situation, try to close as many non-essential running applications to 
restore the available amount of DOS memory.
NOTE: Do not confuse DOS memory with the memory available upon opening a DOS session through 
Windows. DOS sessions are created using a portion of Windows memory to duplicate a DOS 
environment.
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GDI Resources command (Sensor menu)
See Also
This command allows you to enable and display the GDI Resources sensor in the System Watch window.
The GDI Resources sensor monitors the percentage of resources used (or free) from the graphics display
interface (GDI) module, which is responsible for controlling graphics output such as drawings or bitmaps, 
to display devices.
NOTE: The About... command in the Help menu displays the amount of "Free Resources" available to 
your system. Windows displays either the amount of free GDI resources, or the amount of free USER 
resources, whichever is lower. Keep in mind that the value obtained by the About... command and the 
value obtained by the System Watch USER and GDI Resources sensor may differ because of the static 
nature of the About... Free Resources value.



Customizing System Watch
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User Resources command (Sensor menu)
See Also
This command allows you to enable and display the USER Resources sensor in the System Watch 
window. When this command is selected, a check mark appears next to the command.
The USER Resources sensor displays the percentage of resources used from the USER module. USER 
resources manage Window operations such as displaying confirmation dialog boxes and maintaining 
application menus, and is usually the first to deplete compared to the GDI resources.
NOTE: The About... command in the Help menu displays the amount of "Free Resources" available to 
your system. Windows displays either the amount of free GDI resources, or the amount of free USER 
resources, whichever is lower. Keep in mind that the value obtained by the About... command and the 
value obtained by the System Watch USER and GDI Resources sensor may differ because of the static 
nature of the About... Free Resources value.



Configuring the Windows Memory Sensor
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CPU Utilization command (Sensor menu)
See Also
This command allows you to enable and display the CPU Utilization sensor in the System Watch window.
The CPU Utilization sensor displays the percentage of time the CPU spends executing instructions versus
the time spent idle (not processing).
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System Handles command (Sensor menu)
See Also
This command allows you to enable and display the System Handles sensor in the System Watch 
window.
The System Handles sensor monitors the number of free (or used) global memory handles or selectors. 
Handles are used by Windows and Windows applications to manage memory.
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Open Files command (Sensor menu)
See Also
This command allows you to enable and display the Open Files sensor in the System Watch window.
The Open Files sensor displays the total number (or percentage) of open files used by both DOS and 
Windows. The maximum number of open files you can have on your system while running Windows is 
127.



Customizing System Watch
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Cache Hit Ratio command (Sensor menu)
See Also
This command allows you to enable and display the Cache Hit Ratio sensor in the System Watch window.
The Cache Hit Ratio sensor displays the percentage of time your software drive cache has found 
information in memory versus the number of times it had to retrieve the information from your hard disk. 
Cache hit information can be obtained by System Watch for Microsoft SMARTDrive, Norton Cache, and 
Norton Speedrive.



Configuring the Open Files Sensor
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Drive d: command (Sensor menu)
See Also
This command allows you to enable and display the Drive d: sensor in the System Watch window, where 
d is the drive letter of your local hard drive. If your drive is partitioned into several drives, System Watch 
can monitor and display the status of each one in the System Watch window.
The Drive d: sensor displays the amount of free (or used) space on your local hard drive, and can be 
displayed as a percentage used (or free), or in megabytes (MB), kilobytes(KB), or bytes.



Customizing System Watch
Configuring the Disk Usage Sensor



Enable All command (Sensor menu)

Use this command to automatically enable all System Watch sensors. When this command is selected, all
sensors will be displayed in the System Watch window.
NOTE: By selecting this command, all sensors will be enabled and displayed. However, the Enable Alarm
check box will not be automatically enabled for each sensor. Be sure to verify the sensors for which you 
want alarms enabled.



Windows Memory command (History menu)
See Also
Use this command to display a visual representation of your Windows memory. System Watch displays a 
histogram of your Windows memory in 30 second sections. The graph is updated once every second to 
give you instant information relating to your Windows memory.
Also displayed in the Windows memory History window is the current, highest and lowest amount of 
Windows memory measured since the sensor was enabled. In addition, the Windows Memory History 
window also displays the current alarm setting, and the lowest and highest possible value that could be 
theoretically measured of your Windows memory.
System Watch also allows you to minimize the Windows Memory History window. This handy feature lets 
you view several sensor histories at one time, or passively view the sensor levels while you run other 
applications to compare different results. A small histogram is displayed in the icon, along with the current 
value, updated every second.
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Physical Memory command (History menu)
See Also
Use this command to display a visual representation of your Physical memory. System Watch displays a 
histogram of your Physical memory in 30 second sections. The graph is updated once every second to 
give you instant information relating to your Physical memory.
Also displayed in the Physical Memory History window is the current, highest and lowest amount of 
Physical memory measured since the sensor was enabled. In addition, the Physical Memory History 
window displays the current alarm setting, and the lowest and highest possible value that could be 
theoretically measured of your Physical memory.
System Watch also allows you to minimize the Physical Memory History window. This handy feature 
allows you to view several sensor histories at one time, or passively view the sensor levels while you run 
other applications to compare different results. A small histogram is displayed in the icon, along with the 
current value, updated every second.



Configuring the Windows Memory Sensor
Configuring the Physical Memory Sensor
Configuring the Disk Usage Sensor
Viewing Sensor Histories



Virtual Memory command (History menu)
See Also
Use this command to display a visual representation of your Virtual memory. System Watch    displays a 
histogram of your Virtual memory in 30 second sections. The graph is updated once every second to give 
you instant information relating to your Virtual memory. Also displayed in the Virtual Memory History 
window is the current, highest and lowest amount of Virtual memory measured since the sensor was 
enabled. In addition, the Virtual Memory History window also displays the current alarm setting, and the 
lowest and highest possible value that could be theoretically measured of your Virtual memory.
System Watch also lets you minimize the Virtual Memory history window. This handy feature allows you to
view several sensor histories at one time, or passively view the sensor levels while you run other 
applications to compare different results. A small histogram is displayed in the icon, along with the current 
value, updated every second.



Configuring the Windows Memory Sensor
Configuring the Physical Memory Sensor
Configuring the Virtual Memory Sensor
Viewing Sensor Histories



DOS memory command (History menu)
See Also
Use this command to display a visual representation of your DOS memory. System Watch will display a 
histogram of your DOS Memory in 30 second sections. The graph is updated once every second to give 
you instant information relating to your DOS memory. Also displayed in the DOS Memory History window 
is the current, highest and lowest amount of DOS Memory measured since the sensor was enabled. In 
addition, the DOS Memory History window also displays the current alarm setting, and the lowest and 
highest possible value that could be theoretically measured of your DOS memory.
System Watch also allows you to minimize the DOS Memory History window. This handy feature lets you 
view several sensor histories at one time, or passively view the sensor levels while you run other 
applications to compare different results. A small histogram is displayed in the icon, along with the current 
value, updated every second.



Configuring the Virtual Memory Sensor
Configuring the DOS Memory Sensor
Configuring the CPU Utilization Sensor
Configuring the System Handles Sensor
Viewing Sensor Histories



GDI Resources command (History menu)
See Also
Use this command to display a visual representation of your GDI Resources. System Watch displays a 
histogram of your GDI Resources in 30 second sections. The graph is updated once every second to give
you instant information relating to your GDI Resources.
Also displayed in the GDI Resources History window is the current, highest and lowest amount of GDI 
Resources measured since the sensor was enabled. In addition, the GDI Resources History window also 
displays the current alarm setting, and the lowest and highest possible value that could be theoretically 
measured of your GDI Resources.
System Watch also allows you to minimize the GDI Resources History window. This handy feature allows 
you to view several sensor histories at one time, or passively view the sensor levels while you run other 
applications to compare different results. A small histogram is displayed in the icon, along with the current 
value, updated every second.



Customizing System Watch
Configuring the GDI Resources Sensor
Configuring the Cache Hits Ratio Sensor
Viewing Sensor Histories



USER Resources command (History menu)
See Also
Use this command to display a visual representation of your USER Resources. System Watch will display
a histogram of your USER Resources in 30 second sections. The graph is updated once every second to 
give you instant information relating to your USER Resources.
Also displayed in the USER Resources History window is the current, highest and lowest amount of 
USER Resources measured since the sensor was enabled. In addition, the USER Resources History 
window also displays the current alarm setting, and the lowest and highest possible value that could be 
theoretically measured of your USER Resources.
System Watch also allows you to minimize the USER Resources History window. This handy feature lets 
you view several sensor histories at one time, or passively view the sensor levels while you run other 
applications to compare different results. A small histogram is displayed in the icon, along with the current 
value, updated every second.



Configuring the Physical Memory Sensor
Configuring the GDI Resources Sensor
Configuring the USER Resources Sensor
Viewing Sensor Histories



CPU Utilization command (History menu)
See Also
Use this command to display a visual representation of your CPU Utilization. System Watch displays a 
histogram of your CPU Utilization in 30 second sections. The graph is updated once every second to give 
you instant information relating to your CPU Utilization.
Also displayed in the CPU Utilization History window is the current, highest and lowest amount of CPU 
Utilization measured since the sensor was enabled. In addition, the CPU Utilization History window also 
displays the current alarm setting, and the lowest and highest possible value that could be theoretically 
measured of your CPU Utilization.
System Watch also lets you minimize the CPU Utilization History window. This handy feature allows you 
to view several sensor histories at one time, or passively view the sensor levels while you run other 
applications to compare different results. A small histogram is displayed in the icon, along with the current 
value, updated every second.



Customizing System Watch
Configuring the Virtual Memory Sensor
Configuring the CPU Utilization Sensor
Viewing Sensor Histories



Handles command (History menu)
See Also
Use this command to display a visual representation of your System Handles. System Watch displays a 
histogram of your System Handles in 30 second sections. The graph is updated once every second to 
give you instant information relating to your System Handles.
Also displayed in the System Handles History window is the current, highest and lowest amount of 
System Handles measured since the sensor was enabled. In addition, the System Handles History 
window displays the current alarm setting, and the lowest and highest possible value that could be 
theoretically measured of your System Handles.
System Watch also lets you minimize the System Handles history window. This handy feature allows you 
to view several sensor histories at one time, or passively view the sensor levels while you run other 
applications to compare different results. A small histogram is displayed in the icon, along with the current 
value, updated every second.



Configuring the Windows Memory Sensor
Configuring the USER Resources Sensor
Configuring the System Handles Sensor
Viewing Sensor Histories



Open Files command (History menu)
See Also
Use this command to display a visual representation of your Open Files. System Watch displays a 
histogram of your Open Files in 30 second sections. The graph is updated once every second to give you 
instant information relating to your Open Files.
Also displayed in the Open Files History window is the current, highest and lowest amount of Open Files 
measured since the sensor was enabled. In addition, the Open Files History window displays the current 
alarm setting, and the lowest and highest possible value that could be theoretically measured of your 
Open Files.
System Watch also lets you minimize the Open Files History window. This handy feature lets you view 
several sensor histories at one time, or passively view the sensor levels while you run other applications 
to compare different results. A small histogram is displayed in the icon, along with the current value, 
updated every second.



Customizing System Watch
Configuring the CPU Utilization Sensor
Configuring the Open Files Sensor
Viewing Sensor Histories



Cache Hit Ratio command (History menu)
See Also
Use this command to display a visual representation of your Cache Hit Ratio. System Watch displays a 
histogram of your Cache Hit Ratio in 30 second sections. The graph is updated once every second to give
you instant information relating to your Cache Hit Ratio.
Also displayed in the Cache Hit Ratio History window is the current, highest and lowest amount of Cache 
Hit Ratio measured since the sensor was enabled. In addition, the Cache Hit Ratio History window 
displays the current alarm setting, and the lowest and highest possible value that could be theoretically 
measured of your Cache Hit Ratio.
System Watch also lets you minimize the Cache Hit Ratio History window. This handy feature lets you 
view several sensor histories at one time, or passively view the sensor levels while you run other 
applications to compare different results. A small histogram is displayed in the icon, along with the current 
value, updated every second.



Configuring the Cache Hits Ratio Sensor
Configuring the Virtual Memory Sensor
Viewing Sensor Histories



Drive d: command (History menu)
See Also
Use this command to display a visual representation of your disk space. System Watch displays a 
histogram of your disk space in 30 second sections. The graph is updated once every second to give you 
instant information relating to your disk space.
Also displayed in the Drive d: History window is the current, highest and lowest amount of disk space 
measured since the sensor was enabled. In addition, the Drive d: History window also displays the current
alarm setting, and the lowest and highest possible value that could be theoretically measured of your hard
disk space.
System Watch also lets you minimize the Drive d: History window. This handy feature lets you view 
several sensor histories at one time, or passively view the sensor levels while you run other applications 
to compare different results. A small histogram is displayed in the icon, along with the current value, 
updated every second.



Customizing System Watch
Configuring the DOS Memory Sensor
Configuring the Disk Usage Sensor
Viewing Sensor Histories



Close All command (History menu)

Use this command to close all sensor histories you are viewing.



Options... command (File menu)



Always on Top command (File menu)



No Title command (File menu)



Exit command (File menu)



Windows Memory command (Sensor menu)



Physical Memory command (Sensor menu)



Virtual Memory command (Sensor menu)



DOS Memory command (Sensor menu)



GDI Resources command (Sensor menu)



User Resources command (Sensor menu)



CPU Utilization command (Sensor menu)



System Handles command (Sensor menu)



Open Files command (Sensor menu)



Cache Hit Ratio command (Sensor menu)



Drive D: command (Sensor menu)



Enable All command (Sensor menu)



Windows Memory command (History menu)



Physical Memory command (History menu)



Virtual memory command (History menu)



DOS memory command (History menu)



GDI Resources command (History menu)



USER Resources command (History menu)



CPU Utilization command (History menu)



Handles command (History menu)



Open Files command (History menu)



Cache Hit Ratio command (History menu)



Drive D: command (History menu)



Close All command (History menu)



General Options panel (Options... dialog box)
Use this dialog box to change the sensor appearance, sensor display order, or other options such as 
viewing enabled sensors in columns in the System Watch window.
Default command button
Sensors list box
Sensor Appearance group box

Change Background Color button
Change Text Color button
Change Normal Bar Color button
Change Warning Bar Color button
Font drop-down list box

Sensor Order group box
Sensor Order list box
Up button
Down button

Other Options group box
Load With Windows check box
Always On Top check box
No Title check box
Show Alarm Indicator check box
Repeat Alarm Every   N   Minutes text box  
Columns text box



Sensors list box
This list box displays each of the System Watch sensors in addition to the General Options configuration 
panel. Click the sensor you want to configure.



Change Background Color button
Use this button to change the background color of each of the displayed sensors in the System Watch 
window. When you click the  button, the Color Selection dialog box appears. After you have selected a 
background color, a sample sensor display of the color options you have selected are displayed in this 
panel.



Change Text Color button
Use this button to change the text color of each of the displayed sensors in the System Watch window. 
When you click the  button, the Color Selection dialog box appears. After you have selected a sensor 
text color, a sample sensor display of the color options you have selected are displayed in this panel.



Change Normal Bar Color button
Use this button to select the sensor color that is displayed when your system resources are within 
selected limits. When you click the  button, the Color Selection dialog box appears.    After you have 
selected a normal bar color, a sample sensor display of the color options you have selected are displayed
in this panel.



Change Warning Bar Color button
Use this button to select the sensor color that is displayed when your system resources are not within 
selected sensor limits. When you click the  button, the Color Selection dialog box appears.    After you 
have selected a warning bar color, a sample sensor display of the color options you have selected are 
displayed in this panel.



Font drop-down list box
Use this drop-down list box to select the font you want displayed for each of the displayed System Watch 
sensors. A sample of the font you have selected is displayed in this panel.



Show Alarm Indicator check box
Check this box to display the limit you have chosen for each of the sensors. This alarm indicator gives 
you a visual indication of the quantity of resources you have left before a warning message appears.



Repeat Alarm Every N Minutes text box
This text box allows you to choose the time interval that warning messages are displayed. If a resource 
falls below a specified limit, System Watch performs the selected alarm action for that sensor at the 
interval you specify in this text box.



Sensor Order list box
This list box displays each of the sensors System Watch uses. They are displayed in the order they 
appear in the sensor display. Use this list box to change the order the sensors are displayed in the 
System Watch sensor display. To change the displayed sensor order, select the sensor in this list box, and
use either the Up or the Down button.



Up button
Use this button to move a sensor selected in the Sensor list box up in the System Watch sensor display.



Down button
Use this button to move a sensor selected in the Sensor list box down in the System Watch sensor 
display.



Load With Window check box
Check this box if you want System Watch launched each time you run Windows.



Always On Top check box
Check this box if you want the System Watch window displayed on top of any other active window.



No Title check box
Check this box if you want the System Watch window displayed without a title or menu bar. You can also 
view System Watch without the title bar by choosing No Title from the File menu. Double-click anywhere 
in the System Watch window to display the title bar after it has been disabled.
NOTE: You can toggle between displaying the System Watch window with or without a title bar by double-
clicking anywhere in the System Watch window.



Columns text box
Use this text box to specify how many columns you want used to display the System Watch sensors. 
Enter a number in the text box or use the spin button to select a number.



Default command button
Use this command button to reset panel settings to default values.



Windows Memory panel (Options... dialog box)
Use this panel to configure the System Watch Windows Memory sensor to your own preferences. Select 
alarm actions such as playing your favorite WAV file if your Windows memory falls below a selected limit.
Default command button
Sensors list box
Enable Sensor For Windows Memory check box
Enable Alarm check box
Alarm Limit text box
Units Of Measurement drop-down list box
Alarm Action group box

Do Nothing option button
Flash Sensor option button
Play WAV File option button and text box
(Test WAV File) button
Display Recommendation Message option button

Measurement Method group box
Current Value option button
Decaying Average option button

Sensor Display group box
Shows Amount Used option button
Shows Amount Free option button

Sensor Scale group box
Megabytes option button
Kilobytes option button
Bytes option button
Percentage option button
Number option button
Default option button



Enable Sensor For Windows Memory check box
Check this box if you want this sensor enabled and displayed in the System Watch sensor display. If you 
don't want to use this sensor, uncheck this box and the sensor will not be displayed.



Enable Alarm check box
Check this box if you want to enable the alarm for this sensor. When this box is checked, System Watch 
monitors your enabled sensors, and alerts you if a monitored resource falls below the selected limit. If this
box is unchecked and the sensor is enabled, System Watch only displays the sensor level in the selected 
normal color regardless of the level in the System Watch window.



Alarm Limit text box
Use this text box to enter a specific limit you want System Watch to use to determine whether the 
selected resource sensor has fallen below selected parameters. The number you enter here is dependent
upon the units of measurement you have selected in the Units of Measurement drop-down list box.
NOTE: You can also use the alarm limit selection bar below the sample sensor display to select a limit. 
When you move this selection bar to the left or right, a value is displayed corresponding to the position of 
the alarm indicator in the sample sensor display.



Units of Measurement drop-down list box
Use this drop-down list box to select the units of measurement you want to use for the selected sensor. 
Depending on the sensor you choose, you have the choice to view the sensor level in megabytes, 
kilobytes, bytes, or as a percentage.



Do Nothing option button
Select this option button if you don't want a warning message displayed if the selected sensor falls below 
the specified limit. If a resource goes below the specified limit, the appropriate sensor will only change to 
the warning color you have selected in the System Watch window.
NOTE: The Enable Alarm check box must be checked to select this option.



Flash Sensor option button
If a selected sensor detects that its resource is outside of specified limits and this option button is 
selected, the appropriate sensor changes to the selected warning color and blinks in the System Watch 
window.
NOTE: The Enable Alarm check box must be checked to select this option.



Play WAV File option button and text box
Select this option button if you want a WAV file played when the selected sensor falls beyond the 

specified limit. Enter the path name of the WAV file you want played in the text box. Click the  button if 
you're not sure where the WAV file is located.
NOTE: You must have a sound card installed to play WAV files. Also, the Enable Alarm check box must 
be checked to select this option.



 (test WAV file) button
Click this button to test the WAV file you have selected.
NOTE: You must have a sound card installed to play WAV files.



Display Recommendation Message option button
Select this option button if you want System Watch to display a recommendation message when the 
selected sensor falls outside specified limits. The recommendation message gives you helpful tips you 
can use to increase your low resource to within acceptable limits.



Current Value option button
Choose this option button if you want the current value of the selected sensor displayed in the System 
Watch sensor display. System Watch displays the value based on the units selected in the Units of 
Measurement drop-down list box.



Decaying Average option button
Ordinarily, System Watch obtains a new sensor reading for each of the sensors once per second. When 
this option is selected, System Watch adds the new reading to the "last" reading and divides the sum by 
two. The result is what is displayed, and consequently, this value is used as the "last" value on the next 
update.



Shows Amount Used option button
Choose this option button if you want the amount of used resource displayed in the System Watch sensor
display.



Shows Amount Free option button
Select this option button if you want free resource displayed in the System Watch window.



Megabytes option button
Select this option if you want the amount displayed in the selected sensor to be displayed in megabytes.



Kilobytes option button
Select this option if you want the amount displayed in the selected sensor to be displayed in kilobytes.



Bytes option button
Select this option if you want the amount displayed in the selected sensor to be displayed in bytes.



Percentage option button
Select this option button if you want the value displayed in the selected sensor to be displayed as a 
percentage.



Number option button
This option is dimmed and not available for the selected sensor.



Default option button
Select this option button if you want to use the System Watch default unit of measurement.



Physical Memory panel (Options... dialog box)
Use this panel to configure the Physical Memory sensor to your own needs and preferences. Use the 
sliding sensor scale to select a non-precise value for the alarm to monitor, or type in a specific value in the
Alarm Limit text box.
Default command button
Sensors list box
Enable Sensor For Physical Memory check box
Enable Alarm check box
Alarm Limit text box
Units Of Measurement drop-down list box
Alarm Action group box

Do Nothing option button
Flash Sensor option button
Play WAV File option button and text box
(Test WAV File) button
Display Recommendation Message option button

Measurement Method group box
Current Value option button
Decaying Average option button

Sensor Display group box
Shows Amount Used option button
Shows Amount Free option button

Sensor Scale group box
Megabytes option button
Kilobytes option button
Bytes option button
Percentage option button
Number option button
Default option button



Enable Sensor For Physical Memory check box
Check this box if you want this sensor enabled and displayed in the System Watch sensor display.



Virtual Memory panel (Options... dialog box)
Use this configuration panel to set preferences such as alarm actions, or display sensor scale.
Default command button
Sensors list box
Enable Sensor For Virtual Memory check box
Enable Alarm check box
Alarm Limit text box
Units Of Measurement drop-down list box
Alarm Action group box

Do Nothing option button
Flash Sensor option button
Play WAV File option button and text box
(Test WAV File) button
Display Recommendation Message option button

Measurement Method group box
Current Value option button
Decaying Average option button

Sensor Display group box
Shows Amount Used option button
Shows Amount Free option button

Sensor Scale group box
Megabytes option button
Kilobytes option button
Bytes option button
Percentage option button
Number option button
Default option button



Enable Sensor For Virtual Memory check box
Check this box if you want this sensor enabled and displayed in the System Watch sensor display.



DOS Memory panel (Options... dialog box)
Set your preferences for the DOS Memory sensor with this configuration panel. You can enable the alarm 
to alert you when your DOS memory falls below a set limit, or you can simply choose to view the current 
level in the System Watch sensor display window.
Default command button
Sensors list box
Enable Sensor For DOS Memory check box
Enable Alarm check box
Alarm Limit text box
Units Of Measurement drop-down list box
Alarm Action group box

Do Nothing option button
Flash Sensor option button
Play WAV File option button and text box
(Test WAV File) button
Display Recommendation Message option button

Measurement Method group box
Current Value option button
Decaying Average option button

Sensor Display group box
Shows Amount Used option button
Shows Amount Free option button

Sensor Scale group box
Megabytes option button
Kilobytes option button
Bytes option button
Percentage option button
Number option button
Default option button



Enable Sensor For DOS Memory check box
Check this box if you want this sensor enabled and displayed in the System Watch sensor display.



Megabytes option button
This option button is dimmed and not available because you cannot have more than one megabyte of 
DOS memory.



CPU Utilization panel (Options... dialog box)
Use this configuration panel to set the System Watch CPU Utilization sensor to your own preferences. 
The CPU Utilization can only be displayed as a percentage.
Default command button
Sensors list box
Enable Sensor For CPU Utilization check box
Enable Alarm check box
Alarm Limit text box
Units Of Measurement drop-down list box
Alarm Action group box

Do Nothing option button
Flash Sensor option button
Play WAV File option button and text box
(Test WAV File) button
Display Recommendation Message option button

Measurement Method group box
Current Value option button
Decaying Average option button

Sensor Display group box
Shows Amount Used option button
Shows Amount Free option button

Sensor Scale group box
Megabytes option button
Kilobytes option button
Bytes option button
Percentage option button
Number option button
Default option button



Enable Sensor For CPU Utilization check box
Check this box if you want this sensor enabled and displayed in the System Watch sensor display.



Units of Measurement drop-down list box
The only unit of measurement that is used for this sensor is percentage.



Megabytes option button
This option button is dimmed and not used for this sensor.



Kilobytes option button
This option button is dimmed and not used for this sensor.



Bytes option button
This option button is dimmed and not used for this sensor.



Default option button
This option button is dimmed and not used for this sensor.



Open Files panel (Options... dialog box)
Use this panel to configure the Open Files sensor to your own needs and preferences. Select alarm 
actions such as playing your favorite WAV file if your Windows memory falls below a selected limit.
Default command button
Sensors list box
Enable Sensor For Open Files check box
Enable Alarm check box
Alarm Limit text box
Units Of Measurement drop-down list box
Alarm Action group box

Do Nothing option button
Flash Sensor option button
Play WAV File option button and text box
(Test WAV File) button
Display Recommendation Message option button

Measurement Method group box
Current Value option button
Decaying Average option button

Sensor Display group box
Shows Amount Used option button
Shows Amount Free option button

Sensor Scale group box
Megabytes option button
Kilobytes option button
Bytes option button
Percentage option button
Number Of Files option button
Default option button



Enable Sensor For Open Files check box
Check this box if you want this sensor enabled and displayed in the System Watch sensor display.



Units of Measurement drop-down list box
Select the units of measurement you want to use. You can choose to use the percentage of open files or 
the number of open files.



Number of Files option button
Select this option button if you want the sensor to display the number of open files.



GDI Resources panel (Options... dialog box)
Use this panel to set GDI Resources sensor preferences such as alarm actions or the measurement 
method you want to use.
Default command button
Sensors list box
Enable Sensor For GDI Resources check box
Enable Alarm check box
Alarm Limit text box
Units Of Measurement drop-down list box
Alarm Action group box

Do Nothing option button
Flash Sensor option button
Play WAV File option button and text box
(Test WAV File) button
Display Recommendation Message option button

Measurement Method group box
Current Value option button
Decaying Average option button

Sensor Display group box
Shows Amount Used option button
Shows Amount Free option button

Sensor Scale group box
Megabytes option button
Kilobytes option button
Bytes option button
Percentage option button
Number option button
Default option button



Enable Sensor For GDI Resources check box
Check this box if you want this sensor enabled and displayed in the System Watch sensor display.



User Resources panel (Options... dialog box)
Use this panel to set GDI Resources sensor preferences such as alarm actions or the measurement 
method you want to use.
Default command button
Sensors list box
Enable Sensor For User Resources check box
Enable Alarm check box
Alarm Limit text box
Units Of Measurement drop-down list box
Alarm Action group box

Do Nothing option button
Flash Sensor option button
Play WAV File option button and text box
(Test WAV File) button
Display Recommendation Message option button

Measurement Method group box
Current Value option button
Decaying Average option button

Sensor Display group box
Shows Amount Used option button
Shows Amount Free option button

Sensor Scale group box
Megabytes option button
Kilobytes option button
Bytes option button
Percentage option button
Number option button
Default option button



Enable Sensor For User Resources check box
Check this box if you want this sensor enabled and displayed in the System Watch sensor display.



System Handles panel (Options... dialog box)
Use this panel to set configuration preferences for the System Watch System Handles sensor. You can 
choose to display the number of handles available or free, depending on the Sensor Scale option button 
you choose.
Default command button
Sensors list box
Enable Sensor For Selector/Handles check box
Enable Alarm check box
Alarm Limit text box
Units Of Measurement drop-down list box
Alarm Action group box

Do Nothing option button
Flash Sensor option button
Play WAV File option button and text box
(Test WAV File) button
Display Recommendation Message option button

Measurement Method group box
Current Value option button
Decaying Average option button

Sensor Display group box
Shows Amount Used option button
Shows Amount Free option button

Sensor Scale group box
Megabytes option button
Kilobytes option button
Bytes option button
Percentage option button
Number Of Handles option button
Default option button



Enable Sensor for System Handles check box
Check this box if you want this sensor enabled and displayed in the System Watch sensor display.



Units of Measurement drop-down list box
Select the units of measurement you want to use to trigger the System Watch alarm. You have the choice 
to select the percentage or the number of handles used or free, depending on the option button selected 
for the shown amount.



Number of Handles option button
Select this option button to select to display the number of handles used or free in the System Watch 
System Handles sensor display.



Cache Hit Ratio panel (Options... dialog box)
Use this panel to configure the Cache Hit Ratio sensor. Select alarm actions such as playing your favorite 
WAV file if your Cache Hit Ratio falls below a selected limit.
Default command button
Sensors list box
Enable Sensor For Cache Hits check box
Enable Alarm check box
Alarm Limit text box
Units Of Measurement drop-down list box
Alarm Action group box

Do Nothing option button
Flash Sensor option button
Play WAV File option button and text box
(Test WAV File) button
Display Recommendation Message option button

Measurement Method group box
Current Value option button
Decaying Average option button

Sensor Display group box
Shows Amount Used option button
Shows Amount Free option button

Sensor Scale group box
Megabytes option button
Kilobytes option button
Bytes option button
Percentage option button
Number option button
Default option button



Enable Sensor For Cache Hits check box
Check this box if you want this sensor enabled and displayed in the System Watch sensor display.



Disk Usage panel (Options... dialog box)
Use this panel to set sensor preferences for your local hard drives. You can choose to display the amount 
of disk space available (or used), in megabytes (MB), kilobytes (KB), bytes, or as a percentage.
Default command button
Sensors list box
Enable Sensor For Disk Usage check box
Enable Alarm check box
Alarm Limit text box
Units Of Measurement drop-down list box
Alarm Action group box

Do Nothing option button
Flash Sensor option button
Play WAV File option button and text box
(Test WAV File) button
Display Recommendation Message option button

Measurement Method group box
Current Value option button
Decaying Average option button

Sensor Display group box
Shows Amount Used option button
Shows Amount Free option button

Sensor Scale group box
Megabytes option button
Kilobytes option button
Bytes option button
Percentage option button
Number option button
Default option button



Enable Sensor For Disk Usage check box
Check this box if you want this sensor enabled and displayed in the System Watch sensor display.



Color Selection dialog box
Use this dialog box to select sensor display colors. You can choose from a set of basic colors, or create 
your own.
Basic Colors selection boxes
Define Custom Colors command button
Add To Custom Colors command button



Basic Colors selection boxes
Click the color you want displayed in the System Watch sensor display.



Define Custom Colors command button
This button allows you to create your own custom colors to use in the System Watch sensor display.



Add to Custom Colors command button
Click this button after you have defined a custom color to use in the System Watch sensor display. When 
you click this button, the created color will be displayed in the Custom Colors selection boxes.



Contacting Technical Support and Customer Service
To quickly find technical support or customer service information, click on one of the following:

           Customer Service, U.S. and Canada  
           Technical Support, U.S. and Canada  
           Symantec BBS and Other Online Services  
           Fax Retrieval System  
           Customer Service and Technical Support, International  

Customer Service (United States and Canada only)
Symantec Corp.
175 W. Broadway
Eugene, OR    97401

(800) 441-7234 voice
(503) 334-7474 fax
Hours: 7:00 A.M. to 5:00 P.M. Pacific Time
Monday through Friday

Technical Support (United States and Canada only)
Symantec Corp.
175 W. Broadway
Eugene, OR    97401

(503) 465-8440 for Norton Utilities.
Hours: 7:00 A.M. to 4:00 P.M. Pacific Time
Monday through Friday

Symantec BBS and Other Online Services
300-, 1200-, and
2400-baud modems (503) 484-6699 (24 hrs.)
9600-baud modems (503) 484-6669 (24 hrs.)
Settings for the Symantec BBS are:

¨ 8 data bits, 1 stop bit; no parity
Other Online Services
Symantec maintains public forums on both CompuServe and America Online, where you can exchange 
information and ideas with Symantec representatives and with other users of Symantec products.
To access the Norton Utilities Forum on CompuServe:

¨ Type GO SYMUTIL at any ! prompt.
To access The Norton Utilities Forum on America Online:

¨ Choose Keyword... from the Go To menu, type SYMANTEC and click OK. 

Fax Retrieval System (United States and Canada only)
Symantec's Fax Retrieval System provides instant access to general product information, technical notes 
and virus definitions through a 24 hour automated attendant. To access this service, simply have your fax 
number ready and dial (800) 554-4403 from any fax machine or touch-tone phone.

International Technical Support and Customer Service
United Kingdom Symantec UK Limited

Sygnus Court
Market Street
Maidenhead
Berkshire
SL6 4AD
United Kingdom

0628 592 222 voice
0628 592 393 fax

Europe
(all countries except 
UK)

Symantec Europe
Kanaalpark 145
Postbus 1143
2321 JV Leiden
The Netherlands

31 71 353 111 voice
31 71 353 150 fax

Australia Symantec Pty. Ltd.
Upper Level
408 Victoria Road

61 2 879 6577 voice
61 2 879 6805 fax



Gladesville, NSW 2111
Australia

All other countries Symantec Corp.
10201 Torre Ave.
Cupertino, CA 95014
U.S.A.

(408) 252-3570 voice
(408) 253-4992 fax




